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Product Enhancement Overview

Infrastructure Solutions
●     CATIA Infrastructure 

●     CATIA Infrastructure Installation 

●     CATIA ENOVIAvpm Supply Chain Engineering Exchange 

●     Data Exchange Interfaces 

●     ENOVIA-CATIA Interoperability 

●     Product Data Filtering 

●     Real Time Rendering 

●     SMARTEAM CATIA Integration 

●     SMARTEAM CATIA Supply Chain Engineering Exchange 

●     SMARTEAM CATIA Web Integration Product: New 

●     V4 Integration

Mechanical Design Solutions
●     2D Layout for 3D Design 

●     3D Functional Tolerancing & Annotation 

●     Assembly Design 

●     Aerospace Sheetmetal Design 

●     Cast and Forged Part Optimizer 

●     Composites Design 

●     Core and Cavity Design 

●     Functional Molded Part 

●     Generative Sheetmetal Design 

●     Generative Drafting 

●     Interactive Drafting 

●     Mold Tooling Design 

●     Part Design 

●     Sketcher 

●     Structure Design 

●     Wireframe and Surface

Shape Design & Styling Solutions
●     Digitized Shape Editor 

●     FreeStyle Shaper Optimizer & Profiler 

●     FreeStyle Sketch Tracer 



●     Generative Shape Design & Optimizer 

●     Imagine and Shape 

●     Quick Surface Reconstruction

Analysis
●     Advanced Meshing Tools 

●     Generative Structural Analysis

Equipment & Systems Engineering Solutions
●     Compartment and Access 

●     Electrical 3D Design & Documentation 

●     Electrical Cableway Routing 

●     Electrical Connectivity Diagrams 

●     Electrical Harness Flattening 

●     Electrical Harness Installation 

●     Electrical Library 

●     Electrical Wire Routing 

●     Equipment Arrangement 

●     Hanger Design 

●     HVAC Design 

●     HVAC Diagrams 

●     Piping Design 

●     Piping & Instrumentation Diagrams 

●     Raceway & Conduit Design 

●     Structure Functional Design 

●     Tubing Design 

●     Tubing Diagrams 

●     Waveguide Design 

●     Waveguide Diagrams

Machining Solutions
●     3 Axis Surface Machining

●     Advanced Machining 

●     Prismatic Machining 

●     Multi-Axis Surface Machining

●     Multi-Pocket Machining

●     NC Machine Tool Simulation 

●     NC Machine Tool Builder 

●     NC Manufacturing Infrastructure 

●     STL Rapid Prototyping



Product Synthesis Solutions
●     DMU Dimensioning & Tolerancing Review 

●     DMU Fitting Simulator 

●     DMU Kinematics Simulator 

●     DMU Navigator 

●     DMU Optimizer 

●     DMU Space Analysis

●     Human Builder 

●     Knowledge Advisor



Infrastructure User Guide

New Functionalities

Virtual Reality Configurations

Working with Clusters
A new computing system called "cluster" is supported. This system lets you use a set of several computers consisting of 
one master computer and one or many slave computers.

Knowledgeware

About Knowledgeware Relations and Linear Containers
Knowledge features are integrated to the linearity process. To find out more, see also Knowledgeware Features and Linear 
Containers: Special Cases.

Printing Online Documentation

Enhanced online documentation printing
Documentation is no longer delivered in PDF format. However, to enable you to print online documentation more easily, a 
new print engine allows you to display main pages (and all child pages to which the main page is linked) in a separate print 
window.

Enhanced Functionalities

Printing Documents

Customizing Print Settings Before Printing Your Documents
Ability to modify the size of the text displayed in the banner.
Ability to enter a floating-point value when defining the scale of the document to be printed.
A new option lets you use a polyhedral HLR rendering mode.

Printing Documents with Multiple Sheets
Ability to print .CATDrawing documents containing OpenType fonts.

Manipulating Objects

Using the Low Intensity Graphic Property
When applying the Low Intensity graphic property, it is now possible to keep the associated color when displaying objects in 
Shading with Material mode.

Running Batches

Running Batches Using the Batch Monitor
The Knowledgeware Index Generation batch is now available from the Batch Monitor.

Saving Documents

Saving Documents in Other Formats
OpenType fonts are supported when saving a .CATDrawing document in PDF format.
Directional light sources are kept when saving a document in 3D XML format.



Selecting Objects

Selecting Using the Selection Traps
Ability to choose a selection trap mode and use it to make as many selections as needed.

Using Fonts

Customizing Fonts for Displaying Geometry Area Texts
OpenType fonts are now supported when working with .CATDrawing documents.

Using Knowledgeware Capabilities

Generating the Knowledgeware Index
You can generate the index using the dedicated utility.

Viewing Objects

Activating Viewing Tools
The SpacePilot is now supported in WebViewer-derived products: 3D XML Player, 3DCOM Modular, LCA Navigator, 
Smarteam Editor and Smarteam Web Editor.

Customizing Settings

Devices
New parameters are available for working with PC clusters.

Document
A new option lets you run case sensitive searches when searching for DLNames.
A new option lets you perform a quick search for root DLNames.

Navigation
A new option lets you change the value of the rotation angle when rotating objects using the keyboard.

Graphic Formats
Ability to save a multisheet document in a single vectorial file and to set the current sheet of the document as the first page 
of the generated file.

Visualization
A new option lets you use the super sampling technique.



CATIA Infrastructure Installation Guide

New and Enhanced Functionalities

Installation

Support for Windows XP Professional x64 Edition
Version 5 Release 16 supports Windows XP Professional x64 Edition. This Windows 64-bit operating system supports 
processors: AMD Athlon 64, AMD Opteron, Intel Xeon with Intel EM64T support, Intel Pentium 4 with Intel EM64T support.

Windows DLLs
A smaller number of DLLs now needs to be installed during a Version 5 installation, and DLLs are now installed in the 
Version 5 code filetree instead of in the Windows filetree. No DLLs are delivered with Version 5 for the Windows XP 
Professional x64 Edition. The corresponding -dll option of the StartB batch command has consequently been removed. 

Administration

New CATKnowledgePath Environment Variable
The new environment variable CATKnowledgePath has been introduced.



ENOVIA VPM Supply Chain Engineering Exchange

New Functionalities

Automatic Locking of ENOVIA V5 Objects

When reconciling data in ENOVIA V5 VPM, either in batch mode or interactively, the system will automatically attempt to obtain 

locks for all necessary objects (instances, parts documents) based on the reconciliation rules defined.  

New Revision and New Version Rule for  ENOVIA V5 Objects

When setting rules for ENOVIA V5 objects, either in batch mode or interactively, options are available to 

●      save documents to ENOVIA V5 as new revisions.

●     save parts to ENOVIA V5 as new versions and their corresponding geometry documents as new revisions.

Document View

An option to display the objects to be reconciled as documents.

Publication and Attribute Characteristics When Reconciling Objects in ENOVIA V5

The ability to compare attributes between the current CATIA session and the objects in the ENOVIA V5 database has been made 

available.  The comparison can be done based on attributes.

CATMaterial and Catalog Document Types

CATMaterial and Catalog document types are now supported in the reconciliator.  All rules are supported as noted in Defining 

Reconciliation Rules.

Reporting and Printing

At any time during the reconciliation process, a report of the current reconciliation choices you have defined can be generated.  The 

report is saved in an xml file and displayed in your default web browser.  The report can be printed directly from the web browser. 

Options have been added to the CATPDMExtractEV5Batch Batch Process to automatically 
complete the list of documents to be extracted.

Four new options (-completeWithDesign, -completeWithDrawing, -completeWithAnalysis, -completeWithImpactedBy level number|

all_level) are provided to make the extraction of data from ENOVIA V5 easier by limiting the documents you need to explicitly define 

in the command line.  VPM Navigator's impact graph is used to automatically determine the associated documents you want to 

extract.   

Customizing Queries

Queries are used to map objects loaded in CATIA to objects existing in the VPDM.  Three queries exist for mapping objects to 

ENOVIA V5 VPM:  Easy Query, Query Document by Part Id and Query by Object Id.  Custom queries can now be defined based on 

any of the three standard queries.  Custom queries can be added to define which parameters  make up the query and/or supply 



default values for the query parameters.

Intermediate Query for mapping object to ENOVIAVPM

A multi-attribute query has been added for mapping object to ENOVIAVPM.  

Global Set to automatically map the CATIA view with the VPDM view

A new global set has been added which automates the mapping by comparing the instance tree in the CATIA view with the instance 

tree of the VPDM view.

External links to file based documents are re-routed to existing documents in the VPDM.

Enhanced Functionalities

VPDM 3D View Populated From the VPM V5 Repository

When using the VPDM 3D View, CATPart files are loaded from the VPM V5 repository when the DMU cache has been activated.

Publication Exposed Objects can now be mapped from the VPDM View

 

Usability Enhancements

Several features have been added to the Reconciliator to improve usability: 

●     a progress bar has been added to display the completion status of the global query and the global set based on VPDM mapping.

●     a 2D viewer has been added to preview drafting documents

●     when using the query to map objects, the query criteria will be saved so that the same query run on the same object, within a 

single Reconciliator session, will be pre-loaded with the specified values

●     global sets can now be run on sub-assemblies of the structure displayed in the CATIA view

●     when using the query to map objects,  the query function is now accesible from the shortcut menu in the CATIA view.

 



Data Exchange Interfaces

Enhanced Functionalities

DXF/DWG import
AutoCAD 2004, 2005 and 2006 are supported at import.
Import of AutoCAD layer name has been improved.

DXF/DWG export
Export of splines has been improved.

Customizing Settings

DXF/DWG export
The export modes Semantic and Structured have been merged into Semantic as the only difference related to the export of 
dimensions. Consequently, Semantic now offers an option to export V5 dimensions as AutoCAD dimensions as in previous 
releases.
Semantic mode now lets you decide to export V5 layer name as a number or a name.



ENOVIA-CATIA Interoperability

New Functionalities

Opening Data from ENOVIA LCA:

Viewing the Product Structure only
The option Work in DMU Mode is replaced by View Product Structure only, in Tools > Options > General > Compatibility > 
ENOVIA V5 (tab) > CATIA Client Interoperability Administration (title). If this option is checked, a simplified, less-memory-
consuming Product Structure is loaded, only the Technological Packages (TP) can be saved.

How to open two Versions of the same Part in the same Product Structure
There is a new means to use Attribute Mapping in order to load more than one Version of the same Part in the same CATIA 
session.

Saving in ENOVIA LCA:

Warning about Object Mapping when saving configured Move / Replace Operations
Some operations such as Move and Replace, when performed on configured instances, lead to the creation of new instances 
having new UUIDs (Universal Unique Identifier). The newly created instances are not mapped in the CATIA session, hence 
leading to inconsistent behavior. This issue is addressed by a warning.

Managing Contextuality below the PRC
When there is an inconsistency in a Contextual Part between CATIA V5 and ENOVIA LCA, a warning appears preventing the 
Save of this Part. An Interactive Command is also provided to reroute all contextual design to Definition Instance 
automatically. External References that cannot be rerouted automatically will be listed to the user to be rerouted manually 
or to be isolated.

Managing Document Names in ENOVIA LCA and CATIA V5:

About Automatic Renaming
The user has the ability to disable the automatic renaming of duplicated documents and parts.

Highlighting documents in ENOVIA LCA and CATIA V5:

Managing Cross-Highlight between ENOVIA LCA and CATIA V5 when selecting Parts under a workpackage Product
ENOVIA LCA / CATIA V5 cross-highlight capability is accessed through the Identify in ENOVIA LCA command in CATIA V5, 
so that the selected item under a workpackage Product can also be selected in the ENOVIA LCA window as well.
 

For more information:

If you need in particular the following functionalities, you can find them in the VPM Navigator and / or LCA Navigator User's Guides:

●     Mapping Attributes: Document Support.

●     Saving Child Components Without Locking the Parent (Concurrent Engineering).



Product Data Filtering

Enhanced Functionalities

2D Layout for 3D Design data are taken into account by Product to Product and Part to Part, in interactive and in batch mode.



Real Time Rendering

Enhanced Functionality

Materials

Importing and Exporting Materials in 3D XML
Materials applied to CATProducts can now be saved and retrieved in 3D XML format.

 

New Functionality

Materials

Replacing a a material library by another one
It is now possible to replace a material library through the Edit > Links capability.



ENOVIA SMARTEAM - CATIA Integration

New Functionalities

3D XML (EXtensible Markup Language) Format
You can now use 3DXML format to preview CATProduct documents

Enabling Multi-sheet CATDrawing Documents Preview 
You can now enable the preview of the different sheets of a CATDrawing document in the SMARTEAM viewer.

Enhanced Functionalities

Light Weight Mode for Managing Large Assemblies
When loading very large assemblies from the SmarTeam vault, instead of loading and visualizing the whole related CATPart 
documents, it is possible to use alternate CGR (CATIA Graphical Representation) representations just to visualize these 
documents. You can decide which CATPart documents you want to load. This solution optimizes performance.

Managing Catalogs
It is possible to reduce the transfer time from vault to client work. Instead of loading the contents of catalogs, just extract 
the catalog and then the requested parts. This solution optimizes performance.

Inserting Components 
You can now chose between displaying the Search Editor or Insert Components dialog box when using Insert Component.

Undo Check Out
In some cases, it is possible to apply Undo Check Out to modified documents.

Replace with Selected Revision 
In some cases, it is possible to apply Replace with Selected Revision to modified documents.



ENOVIA SMARTEAM - CATIA Supply Chain Engineering 
Exchange

New Functionalities

Report
The Report command generates a synthesis of the reconciliation choices you have made. You can customize the layout of 
the generated report file.

Batch Process
The CATPDMReconcileSTBatch batch process allows you to reconcile large assemblies. Using this tool, you can gain a 
considerable amount of time.

Show SMARTEAM Profile Cards
The Show Profile Card contextual command is available for each object in the CATIA View area.

CATIA 2D View
A CATIA 2D View tab is now displayed in the lower part of the Reconciliator window. It previews CATIA CATDrawing 
documents.

Document View
- Document View: this new view type represents the documents to be reconciled as a tree of documents. 
- VPDM View tab: this new tab displays a tree based on the expanded VPDM root product corresponding to the CATIA root 
product.

Enhanced Functionalities

Global Query
- A progress bar is now displayed during the global query process. It allows you to cancel the process if needed.
- You can now apply Global Set options to a restricted number of objects

Interactive-Latest Available Revision Queries
When defining an interactive query for a given document, the values you enter in the dialog box will be reused the next 
time you will launch again a query for that document. 

Query Contextual Command
You can now search for SMARTEAM objects using the Query contextual command. 

Automatic Pre-selection
Performs automatic queries, object mappings and applies reconciliation rules on the documents to be reconciled. It 
automatically decides which rule to apply on the document to be reconciled.

Customizing your Environment for Reconciling ENOVIA Documents
The CATIA_TEAM_PDM_SUPPLIER_EV5 environment variable is no longer required for ENOVIA V5 VPM and ENOVIAvpm 
supply chain management.



ENOVIA SMARTEAM-CATIA Web Integration Product

ENOVIA SMARTEAM - CATIA Web Integration Product is a seamless, integrated, rapidly usable drawing and document management 

tool for CATIA users. It gives you the power to manage your parts, products and drawings easily, effectively and affordably, and 

provides powerful functions to assist you in building assemblies.

SMARTEAM together with the CATIA Integration product data management solution (PDM) is designed to give you the tools to 

create, edit, view and control CATIA documents, in an intuitive and friendly way. 

SMARTEAM is a revolutionary PDM solution. This philosophy stands behind the product and enables users to install, set up and 

implement a full fledged Product Data Management solution very easily and rapidly, while maintaining a broad spectrum of 

functionality.

SMARTEAM streamlines the flow of documents through an organization's business process, thereby promoting communication, 

cooperation and teamwork. SMARTEAM together with the CATIA Integration provides a process-oriented approach which enables 

individuals to work together as a team throughout a product's life cycle.

What are the benefits of the web based ENOVIA SMARTEAM - CATIA Web Integration 
Product?

ENOVIA SMARTEAM - CATIA Web Integration Product is a new architecture of the SMARTEAM - CATIA Integration based on web 
applications. 

The most important benefit is that no more installation of SMARTEAM is needed on the client. SMARTEAM - Web Editor enables 

secure product lifecycle collaboration through the SMARTEAM database from standard Internet browsers. SMARTEAM -Web Editor 

exploits standard web technologies to provide remote individuals and teams working on multi-platforms, with comprehensive access 

to the central SMARTEAM database and managed files, enabling users to manipulate product data easily in a dynamic and secure 

environment from anywhere.



V4 Integration

New Functionalities

User Interface: a New Icon for V4 elements and for their Hide / Show property

Visualization of the Icon showing the Hide / Show Status for V4 Elements

You can now see, in the specification tree of CATIA V5, if V4 geometry is in Show or Hide mode. This will facilitate the 
browsing of a CATIA V4 model in the V4 model Editor or when it is inserted in a Product.

Enhanced Functionalities

Having Access to V4 Properties

Information about V4 Attributes accessible in the Properties dialog box

The attributes of V4 elements appear in the Properties dialog box. The new Attribute tab allows the user to have access to 
the V4 element information in CATIA V5.

 



2D Layout for 3D Design

New Functionalities

Dimension clipping
        Create, modify or remove a clipping on a dimension. 

Minimum distance dimension
        Create a dimension measuring the absolute minimum distance between two curves, or between a point and a curve.

Open Type Fonts
        On both Unix and Windows, you can use an OTF and parameterize its kerning (for text only).

View background:

●     Smartpick on 2D and 3D background: some Sketcher commands allow you to create 
geometry on background elements.

●     View background manipulation: select and manipulate a 2D Layout view by clicking or 
dragging any element of its background. You can then manipulate easily 2D Layout views 
that do not contain any element and that are represented only by their background.  

2D component instances:

●     Exposed 2D component instance: the new Exposed icon allows you to instantiate and expose 

a 2D component from a catalog. The component instance is not linked to its reference in the 

catalog, but to an identical 2D component reference in a detail sheet.

●     Exploded 2D component instance: the new Explode icon allows you to instantiate and explode 

a 2D component. The component instance is not linked to its reference, so behaves as 

independent geometry and annotations.

●     Fix together constraint on a 2D component instance: the new Fix together icon allows you to 

instantiate and explode a 2D component, with a fix together constraint applied to its 

geometrical elements. 

●     Multiple instantiation from a list of points: multi-instantiate a 2D component using selected 

points as origin points.

Enhanced Functionalities
Dimension leader first part length

        Define a value for the length of a dimension leader first part. You can also manipulate it.

Area fill:



●     Creation: define if the area fill should be isolated or not, via the new Create Datum icon and 

the Tools Palette toolbar.

●     Modification: modify the shape of an associated or isolated area fill.

Low intensity graphic property 
When applying the Low Intensity graphic property, it is now possible to keep the associated color when displaying objects in 
Shading with Material mode. This enhancement is documented in the Infrastructure User Guide.

View creation from...

●     Create an associative view from...: a FTA view, a 3D plane, a Sketch

●     Create an isolated view from...: a FTA view, a 3D plane, a 3D face, a Sketch

●     Create a filtered view from...: a FTA capture

Administration tasks:

●     Support of 2D line type on line, circle and spline: Bidimensional linetypes are now taken into account on 

all monoparametric geometries (line, circle, spline). However, the linetype 8 is an exception: it is taken 

into account on line and circle only (not on spline).

●     Stroke Font: Administrators can manage the print thickness of a stroke font.

●     Engineering symbols list customization: Administrators can add new symbols. They can also modify the 

font and character of symbols provided by default.

Customizing Settings

Area fill customization
        A new option allows you to delete or not the geometry support when deleting an area fill.
        A second option lets you define the area fill detection mode.

Dimension leader first part manipulators
        You can decide to visualize/use or not manipulators to move a dimension leader first part during the creation and/or 
modification of dimensions.

Highlight propagation
        This option allows you to highlight a layout/sheet/view frame with or without its sub-elements.



3D Functional Tolerancing & Annotation

New Functionalities

Positioning Dimension Anchor Points on Geometries of Revolution
This new functionality allows you to position the dimension anchor point (center/axis or edge) of a geometry of revolution 
(circle, cone, cylinder) during the dimension creation between two geometrical elements.

Working with the Assembly Requirements Model
This capability allows you to store the Functional Tolerancing & Annotation features into a part and manage this part in 
ENOVIA V5.

Enhanced Functionalities

Tolerancing & Annotations Properties
The Annotation Set views ratio property allows you to apply a scale factor to all the annotations contained in new 
annotation view of the annotation set. This property is not applicable to an offset or aligned section view, but still applicable 
to its annotation view components.

View Properties
The Ratio property allows you to apply a scale factor to all the annotations contained in a view.

Font Properties
The Kerning property allows you to kern character when using an Open Type Font (OTF).

Value Properties
The Fake Dimension property allows you to specify an user dimension value independent of the dimension geometrical 
support using the Alphanumerical representation.

Managing View/Annotation Plane Associativity
The previous contextual command Manage View Associativity has been renamed as Change View Support.
The dialog box interface has been redesigned: previous options already exist and a new option Invert normal is available.

Querying 3D Annotations
The annotations highlight is disabled when more than 20 geometrical elements are selected, in order to avoid visualization 
and performance depreciation.

Displaying a Tolerancing Capture
Annotations contained in a capture are now automatically mirrored according to the capture orientation.

Dimensioning and Tolerancing Threads
Dimensions created using the Tolerancing Advisor can be set as information (ISO-based standards)/reference (ASME-based 
standards). The information/reference dimension is displayed enclosed by parentheses in geometry window.

Dimension Line Properties
A new leader length property is available.

Engineering Symbols
Administrators can add new symbols. They can also modify the font and character of symbols provided by default.

Creating Dimensions
A minimal distance can be created between canonical surfaces (revolution or planar surfaces) or the projected edge, in the 
current annotation plane, of a non-canonical surface.

Customizing Settings

Manipulators
The new option Move dimension leader allows you to access dimension manipulators to move dimension leader during 
creation or modification.



Assembly Design

New Functionalities

Reordering Applicative Data
This new functionality allows you to manually reorder applicative data entities like scenes, 3D annotations or cameras under 
their respective application node in the specification tree. 

Enhanced Functionalities

Inconsistent or Over-constrained Assemblies
A new mechanism detects constraints redundancy during the constraint creation process and displays the constraints in 
relation with the redundancy.

Assembly Symmetry
New part features can be involved in the Assembly Symmetry feature in addition to the Part Body (or Main Body):

The External View,
All Axis Systems,
All Bodies other than the Part Body,
All Geometrical Sets, ordered or not,
or Any combinations of the previous elements including Part Bodies.

Assembly Symmetry
The Remove All Geometry Links contextual command for a Assembly Symmetry feature in the specification tree is available.
The result is the same as if you unselect the Keep link with geometry option in the Assembly Symmetry Wizard dialog box.



Aerospace Sheetmetal Design

Enhanced Functionalities

Creating a Joggle
You can now select a Runout Joggle Formula from a set of pre-defined formulas, which is to apply on the feature 
parameters.
You can now define the offset surface of a Joggle by selecting an input surface.

Creating a Web
You can now select a curved surface as Support for the web feature.

Interoperability with Knowledge Expert - Sheetmetal Shared Package
You can now use the characteristic curves of Aerospace Sheetmetal features in order to define and run some Knowledge 
Checks through  Knowledge Expert for instance. The targeted checks are clearance ones.

 



Cast and Forged Part Optimizer

New Functionality

Autofillet
The AutoFillet capability fillets and rounds the edges of a part in only one shot.

Enhanced Functionalities

Both Sides Draft Features
Instead of using Advanced Draft to create both sides draft features, we recommend you use Draft Both Sides which offers a 
more user-friendly dialog box. More specifically, it provides helping images which dynamically reflects the geometry you 
select while designing.
Fitted: this option performs a draft operation on two opposite sides of the part while adjusting the resulting faces on the 
parting element you chose.

Advanced Draft
Double-clicking on both side draft features created using Advanced Draft displays the Draft Both Sides dialog box in which 
changing parameters will be done more easily.

Edge Fillet
The Parting Element option withdraws step effects created on the connected edges sharing parting elements of both sides 
drafted parts.



Composites Design

New Functionalities

Retrieving V4 Covering models
You can now transfer v4 Covering models to the Composites Design workbench.

Creating Flattening Process
A new command is available to display the theoretical fiber direction and transferred rosette.

Mirror Part
A new toolbar is available with the following actions:
Create Mirror Part, to create a new part with the Composites features of the original part and their symmetry features.
Synchronize Mirror Part to synchronize the Mirror Part with the original part.

Create Ply Book
A new command is available in the Data Export toolbar to generate a ply book from the manufacturing CPD data structure.

Enhanced Functionalities

Material Definition 
A new attribute called Non structural is added to mark non structural materials as such.

Creating Preliminary Design

Zones Group
An option is added to define zones for the creation of solid from zones only.
These zones can be used in the Solid from Zones and the Connection Generator only.
You can now choose between two types of rosette transfer: Cartesian or Cylindrical.

Cut pieces

Cut-pieces are now associative.
They are taken in account in the following commands:
Ply exploder
Limit contour
Core sampling
Numerical analysis
Material excess
Skin swapping
Creates manufacturing Document

Synchronizes this document 

Creating Plies

Plies Group
You can now choose between two types of rosette transfer: Cartesian or Cylindrical.
Plies groups can be marked as Non structural.

Limit Contour
You can now choose which type of parallel will be used to create the limit contour in Limit Contour and Limit Contours From 
Input File actions.

Ply Table
Capability to export and import a stack-up file from plies with cut-pieces. Following modifications can be done in the stack-
up file before importing and will apply to the model after import:
the cut-piece order in a cut-piece group
the cut-piece/cut-piece group name
rosette



add/remove cut-pieces. 
Creating a Solid from Plies

The solid can be created as colored faces.

Analysis Process

Core Sampling
The core sampling results correspond to the real order of the plies.
You can now either select an existing core sample point or indicate a point (i.e. pick in the 3D area where the core sample 
point should be). 
Non structural plies can be taken into account.

Splice Zones

A new toolbar is available with the following actions:

●     Butt Splice Zones, to define zones where the splicing of plies is performed without 
overlapping,

●     No Splice Zones, to define zones where splicing of plies is not allowed.

Flattening Process

Producibility
Seed point: you can now either select an existing point or indicate a point (i.e. pick in the 3D area where the seed point 
should be). 

Data export

Ply Data Export
The dialog box has been improved.
You can now include the part name, the ply name, the material and the direction in the DXF and IGES 2D files.



Core & Cavity Design

New Functionalities

Pulling Direction Analysis
This command enables you to analyze the pulling direction and related draft angles in order to define the best pulling 
direction. 

Chaining Edges
This command enables you to select and join edges into a parting line.

Parting Line
This command enables you to initialize, improve and analyze a parting line.

Light Surface
This command enables you to create a light surface with respect to the topological definition and disk space.

Reconstruction of fillets
Two new commands Search Fillets and Modify Fillet Radius help you find and reconstruct fillets.

Enhanced Functionalities

Some Generative Shape Design commands are now accessible in this workbench. To ensure the consistency between both 
workbenches, the commands of Core & Cavity Design have been redistributed in the toolbars.
Parting Surface

A new creation mode by direction and length is available. 
The length of existing parting surfaces can be edited.



Functional Molded Part

New Functionalities

Draft Reflect Line
You can now draft a face by using reflect lines as neutral lines from which the resulting faces will be generated.

Displaying a creation context
You can now use the Display Only Parents button to display the creation context of a feature.

Enhanced Functionalities

Manual Update
You can now quickly change the Update Mode by clicking Manual Update.

Specification Tree
Features created via the contextual menu are automatically aggregated under the functional feature.
For more information, refer to Stacking Commands.



Generative Sheetmetal Design

Enhanced Functionalities

Creating walls from an edge
New capabilities have been added:
    Definition of the bend properties is now possible in the Wall on edge dialog box.
    A wall on edge can now be defined from a sketch.
    New height and width limit definitions have been added.
    You can now use an orientation plane and choose a clearance mode to design a wall on edge.

            Tangent walls on edges can now be created.
Creating a bridge

It is now possible to specify if relieves are needed or not and the kind of relief (round or square) during the design of a 
bridge.

Mirroring
It is now possible to mirror an entire body.

Recognizing Features from an Existing Part
You can now select the faces you want to be recognized or the ones you want to be ignored. You can also see the 
recognized features highlighted with a selected color.
You can set specific values of K-Factor for some bends.

Creating a Local Corner Relief
You can now create several Local Corner Relieves in one single step. A new type of corner relief is also available: the 
square corner relief.

Folding and Unfolding Bends
You can now fold or unfold parts with a stamp on or inside a bend. Moreover, an option has been added in the Folding and 
Unfolding Definition dialog boxes allowing you to select or unselect all bending faces to fold or unfold.

 

 

 
 

  



Generative Drafting

New Functionalities

Adding 3D clipping
In the Generative Drafting workbench, you can now define the 3D limits of the view you want to process, without entering 
the DMU workbench.

Clipping view and clipping view profile
From R17, you are proposed two clipping view modes: the new Clipping View command uses a boolean operator from the 
3D whereas the Quick Clipping View command computes the view directly from the 2D projection. Each operation can be 
performed using a circle or a sketched profile as a callout.

Creating associative graphical dress-up
Thanks to the new Create Associative Dress-up icon (in the Tools toolbar), you can now create graphical dress-up that are 
not persistent.

Restoring 3D graphical dress-up
After creating associative dress-up in a view, you can select the 3D properties you want to restore.

Dimension Clipping
You can create, modify or remove a clipping on a dimension.

Enhanced Functionalities

Screw in a threaded hole
In a section view or a breakout view, a screw in a threaded hole is no more considered as a clash, when respecting a few 
listed conditions.

Customization of a Raster view
It is now possible to display in a raster view the same colors as in the 3D geometry.

3D points name
A new Generative View Style parameter specifies whether generated points name should be inherited from 3D or not.

Circular detail View
The leader associated to the circular callout now remains perpendicular to the circle.



Interactive Drafting

New Functionalities
Dimension Clipping

        Create, modify or remove a clipping on a dimension. 

Minimum distance dimension

        Create a dimension measuring the absolute minimum distance between two curves, or between a point and a curve.

Open Type Fonts

        On both Unix and Windows, you can use an OTF and parameterize its kerning (for text only).

Fixing elements together

        Define a rigid behavior for a set of 2D geometric elements.

2D Component Instances:

●     Exposed 2D component instance: the new Exposed icon allows you to instantiate and expose 

a 2D component from a catalog. The component instance is not linked to its reference in the 

catalog, but to an identical 2D component reference in a detail sheet.

●     Exploded 2D component instance: the new Explode icon allows you to instantiate and explode 

a 2D component. The component instance is not linked to its reference, so behaves as 

independent geometry and annotations.

●     Fix together constraint on a 2D component instance: the new Fix together icon allows you to 

instantiate and explode a 2D component, with a fix together constraint applied to its 

geometrical elements. 

●     Multiple instantiation from a list of points: multi-instantiate a 2D component using selected 

points as origin points.

Enhanced Functionalities
Dimension leader first part length

        Define a value for the length of a dimension leader first part, and manipulate it.

Support of 2D line type on line, circle and spline

        Bidimensional linetypes are taken into account on all monoparametric geometries (line, circle, spline).

Area Fill:

●     Creation: define if the area fill should be isolated or not, via the new Create Datum icon and 



the Tools Palette toolbar.

●     Modification: modify the shape of an associated or isolated area fill.

Stroke Font

        Administrators can manage the print thickness of a stroke font.

Engineering symbols list customization

        Administrators can add new symbols. They can also modify the font and character of symbols provided by default. 

Customizing Settings
Area fill customization:

        A new option allows you to delete or not the geometry support when deleting an area fill. 

        A second option lets you define the area fill detection mode.

Dimension leader first part manipulators

        You can decide to visualize/use or not manipulators to move a dimension leader first part during the creation and/or 

modification of dimensions.



Mold Tooling Design

New Functionalities

Split Synchronization
A tool is provided to update splits when the position of the split element has changed.

Technological Results
A tool is provided to generate Technological Results on assemblies created before R16.

Enhanced Functionalities
Selective loading of plates is optimized.
Insertion of component

Selective loading of Mold  Plates is improved.
Improvement of the generic dialog box

It provides enhancements regarding: 
the positioning of elements in the specification tree, 
the definition of the drillings, 
the definition of constraints, 
the definition of the From, 
To and Between fields, 
the definition of the (U,V) origin, 
the definition of the direction,

Copy Reference
This command has been replaced by two more specific commands: Replace Reference (previously Replace Component) and 

Isolate Component.



Part Design

New Functionalities

Pulling Direction Analysis
The Pulling Direction Analysis command enables you to analyze the pulling direction and related draft angles in order to 
define the best pulling direction.

Manual Update
You can now quickly change the Update Mode by clicking Manual Update.

Enhanced Functionalities

Reorder
You can now reorder features in three ways:

❍     After a feature you select (default option)

❍     Before a feature you select

❍     Inside a body, a solid body or a geometrical set. 

Technological Results
Technological Results now takes knowledge parameters as well as User Defined Features (UDF) into account.

Rib
The Move profile to path option allows you to easily associate profiles with center curves but also sweep a single sketch 
along multiple center curves.

Slot
The Move profile to path option allows you to easily associate profiles with center curves but also sweep a single sketch 
along multiple center curves.

Variable Radius Fillet
The No internal sharp edges option removes all possible sharp edges generated by the Variable Radius Fillet command.

Thread
Three additional parameters dedicated to thread features can now be set when using Formula.  

Split
If the splitting element is a surface or a non-planar face, it must intersect the element to be cut before being selected. 
Otherwise the split feature will be generated but no material will be cut.
 



Sketcher

Enhanced Functionalities

Profile Features
- Dialog box display: As soon as Profile Feature is selected, the Profile Definition dialog box is displayed even if no geometry 
is selected.
- Default options: The parameters and options defined for a profile are kept as default values for the next profile you will 
create later on.
- Delete contextual command: it is now possible to remove geometrical elements from the input geometry selection.

Fix Together
- Dialog box display: As soon as Fix Together is selected, the Fix Together Definition dialog box is displayed even if no 
geometry is selected.
- Delete contextual command: it is now possible to remove geometrical elements from the input geometry selection.

 



Structure Design

New Functionality

You can edit the material, grade and thickness or section properties of a profile or plate.
The attribute transfer process that is necessary for generating piece parts is explained.

Enhanced Functionality

You can rearrange the product structure in the specifications tree after a piece part has been generated, using a cut and paste 
process.
The process used to create plates, shapes, and end plates, has been modified, with a new interface and new procedures for material 
management.
Structures drafting now has an enhanced reference plane display.



Wireframe and Surface

New Functionality

Transferring Elements

Enhanced Functionalities

Creating Points
You can now select an optional support when creating a point "Between".

Creating Projections
When the Nearest Solution option is checked and several solutions are possible, you can now choose the solution.

Creating Blended Surfaces
New smooth parameters section.

Keeping the Initial Element
When selecting input elements that are in no show using both datum and no keep modes, the result will be in no show too.

Replacing Elements
You can now check that a replacing feature has been inversed at edition ("Inverse" feature is no longer created).

Keeping the Initial Element
When selecting input elements that are in no show using both datum and no keep modes, the result will be in no show too.

Unfolding a Surface
New options are available to reverse and swap the directions.
You can now select the surface type, either a ruled surface or any type or surface.
You can now display length distortions.

 



Digitized Shape Editor

New Functionalities

Reposit
The three commands Align with Cloud, Align with Surface and Align with Points are replaced by the new command Align by 
Best Fit.
A new command is available: Align with RPS (Reference Point System).

Enhanced Functionalities

Import
3d-Xml (tessellated) and Opton formats are now available.
Setting the scan delimitors to  LH enables you to import Perceptron (ascii) files.

Export
Multi-selection is now available.
You can create one or several export files.
You can choose the axis system in which the export will be performed.

Planar sections
Multi-selection is now available.
You can now process surfaces and volumes.
The management of input curves has been improved.
Output scans can be grouped in one entity, or by element or plane.



FreeStyle Shaper Optimizer & Profiler

Enhanced Functionalities

Breaking Curves
This functionality allows you to break a curve by any combination of points, curves, planes and surfaces.

Breaking Surfaces
This functionality allows you to break a surface by any combination of curves, planes and surfaces.

Performing a Surface Curvature Analysis
You can now make an analysis using the OpenGL shader technology.
The new Highlight option disable the Highlight faces and edges option which highlight of the geometry selection.

Dashboard Toolbar
The Quick Compass Orientation icon is now available from the Dashboard toolbar.
The manipulator position display for the control points is available from the Dashboard toolbar.

Using Control Points
The Control Points dialog box interface has been redesigned:

The selected elements list can be editable.
A new command is available to deselect all the control points.
New options are available to link/unlinks the diffusion and cross diffusion laws and to display the maximal 
deviation.

Creating a Matching Constraint
The Match Constraint command has been redesigned to offer more options and capabilities. 

Customizing Settings

General
The new option All Mesh in Selection focus section allows you to select all the mesh when editing control points.

Manipulators
The new option Pre-selection feedback in Translator properties section allows you to indicate the pre-selected element, 
point or mesh, while editing control points.

Manipulators
The Mesh properties option allows you to customize surface, face and point representations while editing control points.

Manipulators
The Mouse option allows you to customize the displayed cursor while editing control points.



FreeStyle Sketch Tracer

New Functionalities

Managing Interactive Views
Managing Conical Views

Enhanced Functionalities

Positioning using the Cylindrical View
Positioning using the Conical View

New Axis System option to select either an axis system within a part or the part's axis system

 



Generative Shape Design & Optimizer

New Functionalities

Working With the WYSIWYG Mode
Transferring Elements
Inserting A Body In An Added Volume
 

Enhanced Functionalities

Creating Points
You can now select an optional support when creating a point "Between".

Creating Projections
When the Nearest Solution option is checked and several solutions are possible, you can now choose the solution.

Creating Reflect Lines
New type: Conical.

Creating Corners
For 3D corners, the direction is now optional: if no direction is specified, the optimal direction is computed.

Creating Blended Surfaces
New smooth parameters section.

Smoothing Curves
In case of closed curves, the closure vertex may be changed.

Creating Swept Surfaces Using a Circular Profile
New type: Limit curve and tangency surface.

Creating Variable Radius Fillets
The Minimize internal sharp edges option allows you to restrict the number of sharp internal edges generated by the 
Variable Radius Fillet command.

Replacing Elements
You can now check that a replacing feature has been inversed at edition ("Inverse" feature is no longer created).

Keeping the Initial Element
When selecting input elements that are in no show using both datum and no keep modes, the result will be in no show too.

Advanced Tasks

Instantiating Power Copies Using One Step Instantiation
Instantiating Power Copies Using Step by Step Instantiation  
Instantiating Power Copies Using Part Comparison Instantiation 

New Destination field.
Instantiating Power Copies Using Step by Step Instantiation  
Instantiating Power Copies Using Part Comparison Instantiation 

You can now manage the display of a feature when it is edited in the Comparison Window
Instantiating Power Copies Using Part Comparison Instantiation 
Instantiating Power Copies Using Step by Step Instantiation

You can now launch the Quick Select command from both left and right windows.
Unfolding a Surface

New options are available to reverse and swap the directions.
You can now select the surface type, either a ruled surface or any type or surface.
You can now display the optional edges to tear in the 3D area.
You can now display length distortions.

Creating a Mating Flange
It is now mandatory to select a reference direction.
New Linked directions option to link both reference directions

Synchronization
The Synchronize Commands icon is now available with the 2D mode and the Quick Select command.

                 



Imagine & Shape

New Functionalities

Miscellaneous

Adding Sections to A Closed Primitive
This new capability lets you add sections to a circular closed primitive.

Adding Sections to An Open Primitive
This new capability lets you add sections to a circular open primitive.

Defining The Working Zone
This new capability lets you define a working area on a mesh in order to modify only this part of the mesh.

Performing A Symmetry
This new capability lets you perform a symmetry of a subdivision surface.

Performing Shape Operations
This new toolbar lets you access a set of functions belonging to the Generative Shape Design workbench.

Modifying and Deforming Surfaces

Moving Along Normals
This new capability lets you you translate vertices along their normal, as if performing a local offset

.
Picking Elements

This new capability lets you pick one ore more elements in the 3D area.

Modifying and Deforming Curves

Defining the Curve Characteristics
This new capability lets you display and modify the curve characteristics.

Displaying The Transformations Icons
Managing the Compass
Translating a Curve
Rotating a Curve
Scaling a Curve
Using the Edition Panel
Setting the Attenuation Factor

Enhanced Functionalities

Working With The Imagine and Shape Product
When an element is already selected before entering a command, it is used to define the position and orientation of the 
created primitive.

Selecting Elements
New icon to select all elements.

Using the Edition Panel
New icons are available in the Translation dialog box to position the selected vertices.

Cutting Faces
New slider and new Cutting Input icon allowing to define the number of cuts.

Subdividing Faces
New slider and new Subdivision Input icon allowing to define the ratio.

Erasing Faces
New Edge Erasing icon to erase an edge.

Associating Elements 
You can now link a subdivision surface to a point or another subdivision surface.



Customizing

General Settings

Two new options are available to center the subdivision surface.

 
              

 



Quick Surface Reconstruction

New Functionalities
Deviation Analysis

Enhanced Functionalities
Planar sections

Multi-selection is now available.
You can now process surfaces and volumes.
The management of input curves has been improved.
Output scans can be grouped in one entity, or by element or plane.

Automatic Surface
Improved respect of fillets with small radius.
Check box to activate or deactivate full internal tangency between faces of the output surface.



Advanced Meshing Tools

New Functionalities

Quality

Identifying Duplicate Nodes
You can identify and visualize duplicate nodes.

Unmeshed Domains
You can identify and focus on unmeshed domains.

Enhanced Functionalities

Surface Meshing

Entering the Surface Mesher Workshop
A new global parameters in the Mesh tab.

Entering the Advanced Surface Mesher Workshop
A new global parameter in the Mesh tab.
A new global parameter in the Geometry tab.

Solid Meshing

Sweep 3D Mesher
You can now choose guides in the sweep 3D mesher.

Quality

Free Edges
A dialog box is now provided to browse free edges.

Checking Intersections / Interferences
You can filter mesh parts in the interference check.

Mesh Transformations

Coating 1D Mesh
You can select groups under mesh parts as support of the local specifications.

Coating 2D Mesh
You can select groups under mesh parts as support of the local specifications.



Generative Structural Analysis

New Functionalities

Sensors

Creating Internal Load Sensors
You can create a new type of resultant sensor: internal load sensor.

Reference

Removing Geometrical Supports
You can remove in one shot a multi-selection of geometrical supports.

Frequently Asked Questions

Journaling
You can find the list of functionalities you can automate.

Enhanced Functionalities

Computation

Singularity Computation
The singularity computation has been redesigned.

Results Visualization

Available Images
Free body force vector and Free body moment vector images are available for the Analysis Solution set.
Thickness fringe (lamina) and Thickness text (lamina) images are available for the Properties set.

Advanced Edition for Images and Local Sensors
New options are available in the Visu tab of the Image Edition dialog box.

Exporting Data
You can export images in the 3D XML format.



Compartment and Access

New Functionality

Copying Attributes explains how to copy selected attributes from one object to another. 

Enhanced Functionality

You can now manage regenerated compartments by simulating split and merge operations on old or existing compartments.



Electrical 3D Design & Documentation

New Functionality

Routing Simulation
Simulates the signal route, and computes and displays the total wire length



Electrical Cableway Routing

New Functionality

The Manage Cables from Database command lets you select cables from the ENOVIA database. You now must load cable data from 
the database before you can perform any operation on the cable. You then choose to fully route cables or partially route a cable 
from one light network object to another. Additionally, the following can now be performed from the Electrical Cable Database Cable 
Selection dialog box: Analyze data from a cable route and from a light network object. View previously defined routing rules, and 
allow cable routes to violate these rules if necessary. Override violations of defined routing rules. Lock and unlock cable routes.



Electrical Connectivity Diagrams

New Functionality

Moving Schematic Objects explains how to use the Select command or the Schematic Translate command to move schematic objects 
in your document. You can choose to include line segments of network extremities as part of your move operation, and retain the 
shape (length and direction) of these segments.
Sliding In-Line Components explains how to slide an in-line component along a route and around route corners. When you slide an 
in-line component along a route, you retain the shape (length and direction) of the line segments.
Pushing Route Segments shows how to push route segments using the push segment manipulators.
Copying Attributes explains how to copy selected attributes from one object to another.
You can generate reports from one or more parts catalogs using this process.

Enhanced Functionality

You can manually change the scale of a component using the manipulator.



Electrical Harness Flattening

New Functionalities

Arranging junctions
You can automatically arrange the breakout angles between branches at junctions according to an equal angle pattern, or 
an umbrella-like pattern. A User Pattern command also lets you define your own branch arrangement rules. 

Mapping flattened harness views and 3D harness documents
You can manually update flatten links or remove flatten links of a component, or have the system automatically update 
flatten links of a complete harness.

Quick roll
You can now turn a bundle segment about a selected point along the bundle segment.

Enhanced Functionalities

Flattening Parameters - Link
This new tab lets you define the algorithm to use and tolerance values for the automatic update flatten link command.

Extracting 3D data
A new option using a synchronize algorithm provides better PLM integration and outputs a HTML report about the extract 
process at this step. 

Flattening the Entire Harness
Harnesses containing closed loops are now detected and can be flattened.

Rotating bundle segments
You can now rotate bundle segments around branch points.  You can now also select a bundle segment as the direction of 
rotation.

Bending bundle segments
This function is now handled in a separate command (and no longer in the Rotate command). You can now also select a 
bundle segment as the direction for the bend.

Multi-profile branches
Multi-profile branches are now handled by Extract, Flatten, Straighten, Rotate, Roll, Scale and Synchronize commands. You 
can also generate a drawing view of a harness containing multi-profile branches with branches represented as single or 
double lines.

Integrating mechanical parts
The link between bundle segments and mechanical parts is now visualized by a dashed green line in Extract, Flatten, 
Straighten, Rotate, Roll, Scale and Synchronize commands, as well as in drawings generated using generative view styles.

Automatically generating dress-up features
Text template leaders now point to the ends of protective coverings. 
The electrical language dictionary is automatically loaded if not already loaded ensuring that text templates with electrical 
attributes are properly generated by the Automatic Generation command. 
The Update Dress-up command now updates text templates created manually by the user. 
2D details showing support sections can now be generated automatically.



Electrical Harness Installation

New Functionalities

Deleting broken publications
A new menu command lets you clean the multi-branchable document of publications that are no longer referenced.

Duplicating harnesses
A new toolbar command lets you duplicate geometrical and/or electrical bundles previously stored in ENOVIA as 
workpackages.

Enhanced Functionalities

Allow system to use a smaller bend radius value
Using the standard algorithm, a new option optimizes the bend radius in order to keep the flexible curve. The computed 
bend radius is displayed for information in the Branch Definition dialog box.

Computing bundle segments using the FLEX algorithm
The FLEX algorithm now takes into account internal splices.

Electrical and Knowledge
One new user function, and one new attribute (IsGeoAndElecConnectionSame:boolean) have been added

 

 

 



Electrical Library

Enhanced Functionalities

Connecting devices
You can now place and connect both one filler plug and one contact in a cavity

Dragging and dropping devices from a catalog
You can now drag and drop a contact onto a cavity containing a filler plug and a filler plug onto a cavity containing a 
contact. Dragging and dropping a filler plug onto a single insert connector instantiates and connects the filler plug in all 
spare (no wires connected) cavities.

Internal splice
Two additional attributes are available: length and equivalent thickness. These attributes are used when computing bundle 
segments using the FLEX algorithm in Electrical Harness Installation.
 



Electrical Wire Routing

Enhanced Functionality

Routing Simulation
Now computes and displays the total wire length



Equipment Arrangement

New Functionality

Creating an assembly. You can group several parts in an assembly and store the assembly in the catalog. You can add parts from 
any 3D application in the assembly.
The methodology you should follow to create multi-discipline equipment and nozzles is explained.
You can generate reports from one or more parts catalogs using this process.
You can use the Activate Grids command to activate a plane system grid.
New sections explain how to build a loose part and an insulation part.
Copying Attributes explains how to copy selected attributes from one object to another.

Enhanced Functionality

An option you can set allows ignoring of compatibility checks when placing parts.
The procedure for managing logical publications has been modified.
A new option allows you to use a dialog box to select the connector on which to place a part, and is useful in busy documents.
The procedure for creating and modifying catalogs has been changed.
Analyzing Object Information - You can select objects in your 3-D document (runs, connectors) and display attributes such as part 
number and part type in a dialog box.
You now use the Connect Parts dialog box to connect two objects, and the Disconnect Parts dialog box to disconnect. 
You now can create up to 20 graphic representations for each application. Among other changes, you now can choose to display a 
view-specific 3-D symbol at the connectors of the generated part.



Hanger Design

New Functionality

You can generate reports from one or more parts catalogs using this process.
You can use the Activate Grids command to activate a plane system grid.
Copying Attributes explains how to copy selected attributes from one object to another.
Validating and Updating a Penetration explains how to use the Validate and Update command to split a penetration when you have 
two or more clashes, but only one penetration.

Enhanced Functionality

The procedure for managing logical publications has been modified.
The procedure for creating and modifying catalogs has been changed.
Analyzing Object Information - You can select objects in your 3-D document (runs, connectors) and display attributes such as part 
number and part type in a dialog box.
You now use the Connect Parts dialog box to connect two objects, and the Disconnect Parts dialog box to disconnect. 
You now can create up to 20 graphic representations for each application. Among other changes, you now can choose to display a 
view-specific 3-D symbol at the connectors of the generated part.



HVAC Design

New Functionality

The flexible routing function has been redesigned and includes several new features, including the ability to route from a connector, 
route with an offset, apply torsion to a part and addition of the swivel feature.
You can generate reports from one or more parts catalogs using this process.
The redesigned insert nodes function allows you to insert a node in a run with more flexibility.
You can use the Activate Grids command to activate a plane system grid.
New sections explain how to build a loose part and an insulation part.
Copying Attributes explains how to copy selected attributes from one object to another.
Validating and Updating a Penetration explains how to use the Validate and Update command to split a penetration when you have 
two or more clashes, but only one penetration.

Enhanced Functionality

The procedure for managing local slack when routing flexibles has been modified.
An option you can set allows ignoring of compatibility checks when placing parts.
The breaking a run function has changed and now provides several added features.
The procedure for managing logical publications has been modified.
A new option allows you to use a dialog box to select the connector on which to place a part, and is useful in busy documents.
The procedure for creating and modifying catalogs has been changed.
Analyzing Object Information - You can select objects in your 3-D document (runs, connectors) and display attributes such as part 
number and part type in a dialog box.
You now use the Connect Parts dialog box to connect two objects, and the Disconnect Parts dialog box to disconnect. 
You now can create up to 20 graphic representations for each application. Among other changes, you now can choose to display a 
view-specific 3-D symbol at the connectors of the generated part.



HVAC Diagrams

New Functionality

Moving Schematic Objects explains how to use the Select command or the Schematic Translate command to move schematic objects 
in your document. You can choose to include line segments of network extremities as part of your move operation, and retain the 
shape (length and direction) of these segments.
Sliding In-Line Components explains how to slide an in-line component along a route and around route corners. When you slide an 
in-line component along a route, you retain the shape (length and direction) of the line segments.
Pushing Route Segments shows how to push route segments using the push segment manipulators.
Copying Attributes explains how to copy selected attributes from one object to another.
You can generate reports from one or more parts catalogs using this process.

Enhanced Functionality

You can manually change the scale of a component using the manipulator. 



Piping Design

New Functionality

You can generate reports from one or more parts catalogs using this process.
The redesigned insert nodes function allows you to insert a node in a run with more flexibility.
You can use the Activate Grids command to activate a plane system grid.
New sections explain how to build a loose part and an insulation part.
Copying Attributes explains how to copy selected attributes from one object to another.
Validating and Updating a Penetration explains how to use the Validate and Update command to split a penetration when you have 
two or more clashes, but only one penetration.

Enhanced Functionality

An option you can set allows ignoring of compatibility checks when placing parts.
The breaking a run function has changed and now provides several added features.
The procedure for managing logical publications has been modified.
A new option allows you to use a dialog box to select the connector on which to place a part, and is useful in busy documents.
The procedure for creating and modifying catalogs has been changed.
Analyzing Object Information - You can select objects in your 3-D document (runs, connectors) and display attributes such as part 
number and part type in a dialog box.
You now use the Connect Parts dialog box to connect two objects, and the Disconnect Parts dialog box to disconnect. 
You now can create up to 20 graphic representations for each application. Among other changes, you now can choose to display a 
view-specific 3-D symbol at the connectors of the generated part.



Piping & Instrumentation Diagrams

New Functionality

Moving Schematic Objects explains how to use the Select command or the Schematic Translate command to move schematic objects 
in your document. You can choose to include line segments of network extremities as part of your move operation, and retain the 
shape (length and direction) of these segments.
Sliding In-Line Components explains how to slide an in-line component along a route and around route corners. When you slide an 
in-line component along a route, you retain the shape (length and direction) of the line segments.
Pushing Route Segments shows how to push route segments using the push segment manipulators.
Copying Attributes explains how to copy selected attributes from one object to another.
You can generate reports from one or more parts catalogs using this process.

Enhanced Functionality

You can manually change the scale of a component using the manipulator.



Raceway & Conduit Design

New Functionality

The flexible routing function has been redesigned and includes several new features, including the ability to route from a connector, 
route with an offset, apply torsion to a part and addition of the swivel feature.
You can generate reports from one or more parts catalogs using this process.
The redesigned insert nodes function allows you to insert a node in a run with more flexibility.
You can use the Activate Grids command to activate a plane system grid.
New sections explain how to build a loose part and an insulation part.
Copying Attributes explains how to copy selected attributes from one object to another.
Validating and Updating a Penetration explains how to use the Validate and Update command to split a penetration when you have 
two or more clashes, but only one penetration.

Enhanced Functionality

The procedure for managing local slack when routing flexibles has been modified.
An option you can set allows ignoring of compatibility checks when placing parts.
The breaking a run function has changed and now provides several added features.
The procedure for managing logical publications has been modified.
A new option allows you to use a dialog box to select the connector on which to place a part, and is useful in busy documents.
The procedure for creating and modifying catalogs has been changed.
Analyzing Object Information - You can select objects in your 3-D document (runs, connectors) and display attributes such as part 
number and part type in a dialog box.
You now use the Connect Parts dialog box to connect two objects, and the Disconnect Parts dialog box to disconnect. 
You now can create up to 20 graphic representations for each application. Among other changes, you now can choose to display a 
view-specific 3-D symbol at the connectors of the generated part.



Structure Functional Design

New Functionality

Section manipulators display when you are placing stiffeners and beams, allowing you to position them while placing or editing.
You can now create a stiffener on a curved surface, such as a hull, using a 3D curve.
You can edit the material, grade and thickness or section properties of a profile or plate.
Placing Brackets explains how to use the Small Assemblies command to place more than one copy of a bracket in your 3-D session.
Using the Advanced Plate Command explains how to use the Advanced Plate command to create a plate with a concave limit.

Enhanced Functionality

Attributes and anchor points used to define molded conventions have been modified.
You can select points at the intersection of grid lines, allowing you to place an object on the grid by selecting the appropriate points
Structures drafting now has an enhanced reference plane display.



Tubing Design

New Functionality

The flexible routing function has been redesigned and includes several new features, including the ability to route from a connector, 
route with an offset, apply torsion to a part and addition of the swivel feature.
You can generate reports from one or more parts catalogs using this process.
The redesigned insert nodes function allows you to insert a node in a run with more flexibility.
You can use the Activate Grids command to activate a plane system grid.
New sections explain how to build a loose part and an insulation part.
Copying Attributes explains how to copy selected attributes from one object to another.
Validating and Updating a Penetration explains how to use the Validate and Update command to split a penetration when you have 
two or more clashes, but only one penetration.

Enhanced Functionality

The procedure for managing local slack when routing flexibles has been modified.
An option you can set allows ignoring of compatibility checks when placing parts.
The breaking a run function has changed and now provides several added features.
The procedure for managing logical publications has been modified.
A new option allows you to use a dialog box to select the connector on which to place a part, and is useful in busy documents.
The procedure for creating and modifying catalogs has been changed.
Analyzing Object Information - You can select objects in your 3-D document (runs, connectors) and display attributes such as part 
number and part type in a dialog box.
You now use the Connect Parts dialog box to connect two objects, and the Disconnect Parts dialog box to disconnect. 
You now can create up to 20 graphic representations for each application. Among other changes, you now can choose to display a 
view-specific 3-D symbol at the connectors of the generated part.



Tubing Diagrams

New Functionality

Moving Schematic Objects explains how to use the Select command or the Schematic Translate command to move schematic objects 
in your document. You can choose to include line segments of network extremities as part of your move operation, and retain the 
shape (length and direction) of these segments.
Sliding In-Line Components explains how to slide an in-line component along a route and around route corners. When you slide an 
in-line component along a route, you retain the shape (length and direction) of the line segments.
Pushing Route Segments shows how to push route segments using the push segment manipulators.
Copying Attributes explains how to copy selected attributes from one object to another.
You can generate reports from one or more parts catalogs using this process.

Enhanced Functionality

You can manually change the scale of a component using the manipulator.



Waveguide Design

New Functionality

The flexible routing function has been redesigned and includes several new features, including the ability to route from a connector, 
route with an offset, apply torsion to a part and addition of the swivel feature.
You can generate reports from one or more parts catalogs using this process.
The redesigned insert nodes function allows you to insert a node in a run with more flexibility.
You can use the Activate Grids command to activate a plane system grid.
New sections explain how to build a loose part and an insulation part.
Copying Attributes explains how to copy selected attributes from one object to another.
Validating and Updating a Penetration explains how to use the Validate and Update command to split a penetration when you have 
two or more clashes, but only one penetration.

Enhanced Functionality

The procedure for managing local slack when routing flexibles has been modified.
An option you can set allows ignoring of compatibility checks when placing parts.
The breaking a run function has changed and now provides several added features.
The procedure for managing logical publications has been modified.
A new option allows you to use a dialog box to select the connector on which to place a part, and is useful in busy documents.
The procedure for creating and modifying catalogs has been changed.
Analyzing Object Information - You can select objects in your 3-D document (runs, connectors) and display attributes such as part 
number and part type in a dialog box.
You now use the Connect Parts dialog box to connect two objects, and the Disconnect Parts dialog box to disconnect. 
You now can create up to 20 graphic representations for each application. Among other changes, you now can choose to display a 
view-specific 3-D symbol at the connectors of the generated part.



Waveguide Diagrams

New Functionality

Moving Schematic Objects explains how to use the Select command or the Schematic Translate command to move schematic objects 
in your document. You can choose to include line segments of network extremities as part of your move operation, and retain the 
shape (length and direction) of these segments.
Sliding In-Line Components explains how to slide an in-line component along a route and around route corners. When you slide an 
in-line component along a route, you retain the shape (length and direction) of the line segments.
Pushing Route Segments shows how to push route segments using the push segment manipulators.
Copying Attributes explains how to copy selected attributes from one object to another.
You can generate reports from one or more parts catalogs using this process.

Enhanced Functionality

You can manually change the scale of a component using the manipulator.



3 Axis Surface Machining

New Functionalities

Plunge Milling

4-Axis Curve Sweeping
Provides a machining operation with a stepover computed from a planar guide, and a tool with a constant axis, contained in 
a machining plane, and normal to the guide in this machining plane.

Enhanced Functionalities

Roughing
Fully engaged tool management enables you to avoid full material cut by adding trochoid motions or additional machining 
planes.

Slope Area editor
It now provides a better visualization and management of the subsets.

Tool Path Editor
A tool bar is now available.
Better undo/redo management.
Multi-selection of tool paths.
Toggle to display or not points on tool paths.

 



Advanced Machining

New Functionalities

Multi-Axis Tube Machining operation
This new operation allows finish machining of tube or cavity parts that have an obvious central axis or curve.

4-Axis Curve Sweeping operation
New machining operation with a stepover computed from a planar guide, and a tool with a constant axis, contained in a 
machining plane, and normal to the guide in this machining plane.

Plunge Milling operation
New operation in which the tool path is determined by a grid specifying the plunge positions and the order of machining.

Enhanced Functionalities

Local feedrate reduction in Flank Contouring
It is now possible to define a local slowdown rate on each drive of a Flank Contouring operation. This can be combined with 
the Feedrate reduction in corners settings.

Fully Engaged Tool Management in Cavities Roughing and Prismatic Roughing
This parameter is used to manage full material cut when roughing hard material, where the stepover is not always 
respected and where the tool can be damaged.

Additional Thread Milling capabilities 
Existing thread milling operation is enhanced to offer new machining strategies. Multiple helical passes as well as 
conventional and climb cutting are now supported. The thread can be machined from top to bottom of a hole or from 
bottom to top of a hole. Boring bars can now be used in this operation.

Roughing
Fully engaged tool management enables you to avoid full material cuts by adding trochoid motions or additional machining 
planes.

Slope Area Editor
This editor now provides better visualization and improved management of the subsets.

Tool Path Editor
A tool bar is now available.
Better undo/redo management.
Multi-selection of tool paths.
Toggle to display or not display points on tool paths.



Prismatic Machining

New Functionalities

New Plunge Milling operation
Operation in which the tool path is determined by a grid specifying the plunge positions and the order of machining.

Enhanced Functionalities

Additional Thread Milling capabilities 
Existing thread milling operation is enhanced to offer new machining strategies. Multiple helical passes as well as 
conventional and climb cutting are now supported. The thread can be machined from top to bottom of a hole or from 
bottom to top of a hole. Boring bars can now be used in this operation.

Fully Engaged Tool Management in Prismatic Roughing
This parameter is used to manage full material cut when roughing hard material, where the stepover is not always 
respected and where the tool can be damaged.



Multi-Axis Surface Machining

New Functionalities

Multi-Axis Tube Machining
Enables you to machine tube or cavity parts.



Multi-Pocket Machining

Enhanced Functionalities

Power Machining - Center
Fully engaged tool management enables you to avoid full material cut by adding trochoid motions or additional machining 
planes.



NC Machine Tool Simulation

New Functionalities

Users can simultaneously perform material removal and machine simulation
This is possible using NC code only.  Users can also save the machine result in a separate .CATProduct file or associated the 
machined stock with a manufacturing program.

The Stock Analysis functions from NC Manufacturing Verification are available within the NC Tool Simulation workbench
If users have an NC Manufacturing Verification license, they can access the Video Measure, Analyze, and Remove Chunk 
commands available via the Stock Analysis command.

Users can use NC code generated outside of V5
This code can be used for machine simulation and integrated material removal simulation.

Enhanced Functionality

The Process Simulation toolbar has been streamlined
The toolbar includes the commands needed for machine simulation and for material removal simulation, but does not 
contain extraneous commands.  When you select Machine Simulation, you see the toolbar, although if you have not chosen 
to have material removal simulated, not all of the options on the toolbar are available.

Customizing Settings

NC Code Simulation
Users can choose to have material removal simulated.  In addition to controlling material removal simulation, this option 
enables users to save the stock from a machine program or operation, and to control material removal updates.



NC Machine Tool Builder

New Functionalities

NC Machine Tool Builder enables easy modeling and definition of NC machine resources and other peripheral devices used in 
machining. It allows definition and assignment of all relevant parameters, apart from geometry and kinematics, thus enabling a 
unique definition of an NC machine. The resultant NC machine can be used for all machining applications like planning, NC detailing, 
post-processing, verification and simulation.

Apart from the capability to model new machines, Machine Tool Builder enables the import of NC machines modeled in D5 VNC. 
Additional parameters can then be assigned to these machines, enabling them to be used in V5 machining applications.



NC Manufacturing Infrastructure

Enhanced Functionalities

Support of additional compensation points
It is now possible to define additional compensation points on the following tool types: End mills, T-slotters, Taps, Reamers, 
and Thread mills.

Support of spindle speed on tools
In addition to a linear cutting speed, the rotation speed of milling and drilling tools can now also be seen as a spindle speed 
(angular value). 

Partial tool path display
It is now possible to perform a partial tool path replay for the selected activity with most display and visualization options of 
a complete tool path replay.

Tool holder display management
It is now possible to show/hide the holder during tool path replay.
Default tool assemblies and CATProduct user representations of tools are supported.



STL Rapid Prototyping

Enhanced Functionalities

Import
3d-Xml (tessellated) format is now available.
 

Export
Multi-selection is now available.
You can create one or several export files.
You can choose the axis system in which the export will be performed.

Surface Tessellation
Multi-selection is now available.
Distinct or Grouped output is now available.



DMU Dimensioning & Tolerancing Review

New Functionalities
You can now make a review of 2D layout contained in a part and created with the 2D Layout for 3D Design product, from 
the part or assembly context. This review requires no license of 2D Layout for 3D Design and allows you to:

❍     Display the 2D layout window.

❍     Make a non-persistent measure between 2D geometries.

❍     Print 2D layout data.



DMU Fitting Simulator

New Functionality

Generate Track command has been added
Users can select edges on the geometry, and generate tracks from the edges.  Once the initial track has been generated 
from the edges, the track can be modified.

Enhanced Functionalities

Dragging the slider on the Player pop-up toolbar enables users to see the track simulation
In previous releases, users could not see the effects of attaching a section to a track until after a simulation was run; now 
users can see it as they move the slider.

The Player toolbar has a distance parameter
Users can interpolate along the track with a set distance.  Also, the Sampling Step option in the Player Parameters 
dialog box can be set for distance as well as time.

When you select Shuttle, the Preview window now has a Tree tab
This tab enables users to see the names of all parts selected as part of the shuttle.  Users can still preview the graphical 
representations of the parts via the 3D tab.

Shuttles may contain multiple groups and manufacturing assemblies
In previous releases, shuttles could only contain one group and a parent shuttle could reference another shuttle.  In this 
release, each group is treated as an object, and users can select as many objects as they like. Similarly, users can include 
manufacturing assemblies within shuttles.

When you click the Activate Analysis button from the Track dialog box, you can edit the analysis object
Users have the option to edit one analysis object at a time while using the Track command; they do not have to exit the 
Track command and use the analysis commands.

Customizing Settings

Snap Sensitivity in the DMU Manipulation tab has been altered
The default value for the Orientation option has been changed to 20 deg.



DMU Kinematics Simulator

New Functionality

Digital Mockup Review
 Selecting and Opening a Context Product from an Imported Mechanism

You can now easily select and open the context product from either a reference mechanism or an imported mechanism. 



DMU Navigator

Enhanced Functionalities

Customizing DMU Marker
3D Annotations text properties now have dedicated settings.
Marker default properties, 3D Annotation text properties and 2D Annotation text properties  are now found in a new DMU 
Marker tab.

Snapping Components using Multiple Constraints
Invert rotation around the U-axis and the V-axis.

Running the CATDMUUtility Batch Process
VPS format now supported.

Running the CATDMUBuilder Batch Process
3D XML output format now supported.

Managing Annotated Views
Multiple annotated views can now be displayed simultaneously.

 



DMU Optimizer

Enhanced Functionalities

Using Simplification 
Now takes advantage of a new decimation algorithm which produces a better result.



DMU Space Analysis

Enhanced Functionalities

Sectioning

Section Export 
The resulting section curve is now exported as polyline thus ensuring a correct result close to section geometry

Section Result window
You can now customize the size and positioning for the sectioning result window and open multi sections simultaneously 
using a contextual menu command. 

Measure Tools

Exact measure versioning
Exact measures are now versioned, thus ensuring measures created on a specific level are always valid and stable on 
this level.

Interference Checking

Intersection Volumes
Intersection volumes are now taken into account during interferences calculation providing an improved result displaying 
the inertial box.

Exporting Clash Command Results
You can now export intersection volumes in cgr format

Interference selection
It is now possible to display and edit clash selection using the Part Selection functionality in a Process document (with a 
DPM Assembly Process Simulation license)

Customizing Settings

Sectioning     

DMU Sectioning 
You can now customize the sectioning result window (arranging the section viewer size and positioning). New options are 
available in Tools > Options >Digital Mockup >  DMU Space Analysis > Sectioning tab > Result Windows .

Interferences  

DMU Clash - Detailed Computation 
Boolean button not only enables the intersection volumes calculation but also the inertial box display (Tools > Options > 
Digital Mockup > DMU Space Analysis > DMU Clash - Detailed Computation > Intersection Volume) 

DMU Clash 
New option to specify the clash value font size Tools > Options > DMU Clash .



Human Builder

New Functionalities

Using the Auto Place (Z Only)
This describes how to use the Place Mode (Z only) command. This provides you with an easy-to-use tool for placing the 
manikin in the 3D environment, in accordance with the manikin's referential.

The Auto Grasp Toolbar
These functions automatically generate a grasp posture of the hand by checking the collision between the hand and one or 
several objects to be grasped, thereby decreasing the time it takes to create accurate postures.

Positioning objects on an area's surfaces
The Plant Layout workbench allows you to layout a manufacturing facility. One of the objects that Plant Layout can create is 
an "area," which is a solid representation of a floor. Many positioning tools require getting some sort of geometric 
representation for orientation, for example, snapping two objects together, aligning two objects, placing the compass on an 
object, or placing a temporary plane object on the surface. Using these features makes the area pickable, so it behaves 
similarly to a mechanical PAD in that you can place the compass on the area and snap to the orientation the compass 
defines. 

Enhanced Functionalities

Optimize Posture findings for Human Posture Analysis, and Human Activity Analysis
In the Inverse Kinematics (IK) behavior panel, you can choose to optimize the posture according to either Postural Score or 
RULA Analysis. This option is in effect when IK mode or Reach mode is used, as well as when the IK solver is called to 
resolve a constraints update.

Enhanced snap for the Reach Mode command
The Enhanced Snap for Reach Mode Command functionality enables you to get a more predictable and acceptable posture 
of a manikin's segment after a reach using the Reach (Position & Orientation) command. This shortens the time of fine-
tuning the posture after a reach operation.

Plan Orientated Coincidence Constraint for Manikin Segments
You can create a 2D Plan Coincidence constraint between any segments and any plans.  The creation process works exactly 
as it does for the other constraints.  After updating the constraint, the segment is perpendicular to the surface selected for 
the constraint. This highlight adds another type of coincidence constraint, described as a 2 Directions Plane coincidence 
constraint.  The coincidence constraints created in previous versions are Point to Plane coincidence constraints, and are 
defined as such from R17 and onwards.

Gender and Percentile to be maintained on Manikin Instance
This feature allows you to reduce the number of manikin reference files.  In particular, this feature can be applied to 
complex and complete simulation scenarios in which a large number of workers need to be involved, and sometimes 
changed in order to try different modeling alternatives.  You can access this feature through Tools > Options.

Visual Cone Enhancement
The vision cone is an arbitrary limit that can be specified by the user in order to analyze what can be seen by the manikin 
inside a certain degree around the line of sight.  This limit can represent an optical characteristic of the eye, like the limit 
for maximum acuity (approximately 1 degree) or the limit for colors discrimination (around 35 degrees).

Reporting Enhancements
This broadens the spectrum of possibilities of the existing report objects.  First, you can now customize the input 
parameters of reports objects; second, you can see a status report for the manikin; third, you can see a new column in the 
report files that is used to store the input parameters of the reported elements.

Generating a Status Report 
In the Status Report. you can select the items that you want to save in the report.  By default, all the items are checked.

Head/Neck kinematics model enhancement
In  previous releases, the head motion was not natural while the manikin is looking at something located on the side.  In 
this context, moving the compass up and down in IK mode produces lateral movement of the head.



Knowledge Advisor

About Knowledgeware Relations and Linear Containers
Knowledge features are now integrated to the linearity process. To find out more, see also Knowledgeware Features and 
Linear Containers: Special Cases. 
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